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EMBO Practical Course on 
Image Processing for CryoEM 

5th September 2019 

Practical 3 part 1: Tomography with IMOD (version 4.9.12)  
Reconstructing a tomogram of a human neuronal cell 

AIMS 
Today you will be using the IMOD suite of programs to reconstruct a cryo-
tomogram of the periphery of a U87MG cell. The tilt series has been collected 
on FEI Polara 300 kV cryo-electron microscope.  

By the end of this practical, you should be able to: 

• reconstruct a cryo-tomogram step by step, using ETomo, the IMOD’s
Tomography Graphical User Interface (GUI)

• inspect image data and place fiducial landmarks using the 3dmod GUI.

You can visit http://bio3d.colorado.edu/imod/#Guides to learn more about 
IMOD and discover where most of the documentation from this tutorial 
comes from (http://bio3d.colorado.edu/imod/doc/tomoguide.html).  

During this tutorial you can also access detailed information about every step 
in the processing by clicking on the Help tab in the ETomo Main Window 
and selecting Tomography guide. You may also consider joining the IMOD 
mailing list https://bio3d.colorado.edu/imod/joinlist.html 
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Getting started 

Log into the server using the instructions provided. Open a terminal window and in the  
path	/d/embo2019/u/embo##    type: 

> cd Prac-3

and list the contents: 

> ls

You will find two files: 

1. u87mg_60eA_7def_50x_tomo2.st ➜  tilt series as a stack of 2D images, acquired at
different tilt angles,

2. u87mg_60eA_7def_50x_tomo2.rawtlt ➜ a plain text file describing at what angle each
2D image was acquired.

Open up ETomo by typing: 

> etomo

The front page panel of ETomo will appear. Press Build Tomogram, the Setup 
Tomogram panel will appear (shown below). 
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In this panel you will provide ETomo with information of our data. 

Fill in the fields as follows: 

• Dataset name: click on the folder icon near the text box and browse for the
named u87mg_60eA_7def_50x_tomo2.st file.

• Axis Type: make sure the axis type is single axis. This should grey out the ‘Axis
B’ section in the bottom right corner.

• Pixel size/Image rotation: click on the Scan Header button. This will look for
the information in the header of the tilt stack and automatically fill in the pixel
size in nm, 0.422, and image rotation degrees, 83.0, the expected tilt axis of the
tomogram.
IMPORTANT: please note that the image rotation degree of the raw tilt stack
depends on the setup and magnification of the microscope, therefore in some
cases can be closer to 0˚ (almost vertical), and in other cases, like here, close to
90˚ (almost horizontal). In any case, ETomo will automatically rotate final aligned
stack for the output to be vertical.

• Fiducial diameter: this refers to the diameter of the gold particles used as
fiducials to align the stack. In this tomogram they are 10 nm in diameter, so fill it
in as required.

• Axis A: select Tilt angles in existing rawtlt file radio button to tell ETomo that
the tilt angles for this stack are stored in the .rawtlt file. (note: ETomo will search
for a file with the same base name as the tilt stack, but with a .rawtlt extension.)

Leave everything else as default. Backup directory can be left blank, Frame Type should 
be set to Single frame and Remove excluded views can be left unticked. No templates 
have been previously created, so the Template section can be ignored. 

If you haven’t already done so, you can look at the tilt series using the View Raw Image 
Stack button. This will open up 3dmod and two windows will pop up: 

1. The “3dmod control window”, a small window containing menus for performing file
operations, selecting model editing functions, and opening various kinds of image
windows.

2. the “ZaP window”, which is a large window displaying the stack of images.

To scroll through the 2D slices of the raw stack use the cursor in the bar at the top of 
the ZaP window, or the [pgUp] [pgDown] keys, or right click anywhere in the ZaP 
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window to start the automatic scroll. Note that just closing the large ZaP window does 
not also close 3dmod (nor ETomo). In fact, you can re-open the ZaP window from the 
3dmod control window by pressing “Z” or selecting “image>ZaP”. 

Click Create Com Scripts to start the reconstruction workflow, which will appear in a 
new window. Create Com Scripts will also trigger the creation of .com scripts in the 
working directory, that are necessary for advanced batch processing. Luckily, ETomo is 
a friendly user interface, that updates the .com scripts at each step of our reconstruction, 
allowing conventional users to ignore them. 

3dmod 
The control window is a small window containing menus for performing file 
operations, selecting model editing functions, and opening various kinds of image 
windows: 

The “ZaP window”, a large window displaying the stack of images. Here is a brief 
description of key controls at the top of the window: 

Zoom controls
all the buttons. 

Grayscale Intensity 
levels adjustment 

Log window

Image scrolling Click for info on 
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Common problems - setup 
When working with your own data, you may run into one of these problems: 

• The Scan Header does not fill out some fields or fills them out incorrectly, this usually
happens when the header in your stack file is inaccurate. Always make sure these
values are what you expect them to be. Getting them wrong can mess up a lot of the
process, and IMOD might not be able to tell you why it is wrong.

• The Parallel Processing checkbox is greyed out. To fix this you will need to go to the
options menu and select settings. Turn parallel processing on and set the # CPUs to a
number appropriate for your system. Hit Apply. You will then have to exit eTomo and
restart it.

• The .rawtlt file may not be provided. Therefore, other options for defining the tilt
angles include attempting to read them from the tilt stack header (Extract tilt angles
from data) or defining them manually (Specify the starting angle and step and
Series was bidirectional from…). Exclude views allows you to ignore certain views,
in case you might need to do that.

• You may have many more tomograms to reconstruct, all with similar parameters. One
option is to set up a template, so that variables common to all the tomograms are filled
in automatically. Details on how to setup a template can be found at
https://bio3d.colorado.edu/imod/doc/UsingEtomo.html#Templates.
Another option is to try automated batch tomography using batchruntomo. Details can
be found in https://bio3d.colorado.edu/imod/doc/batchGuide.html.
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The Reconstruction Workflow 

On the left panel of the ETomo window, you should now see the pipeline of steps 
required to perform reconstruction. A brief description of each step is given below. 

We will be working through each of these steps in order. Click on Pre-processing to 
continue. 

1. Pre-processing

This step uses the IMOD program ccderaser to correct for pixels with unwanted extreme 
high or low intensity values, erroneously recorded by the detector during image 
acquisition. This may be due to a range of unpredictable events, including random X-
rays in CCD images, glitches in CMOS camera, or other sources of noise. Unfortunately, 
these extreme values can cause artifacts not only in viewing and aligning but can also 
locally affect the quality of the reconstructed tomogram. Thus, if you are unsure whether 
not you need to perform pre-processing, it is always a good idea to perform it. 

- Pre-Processing using ccderaser.

- Perform a rough alignment using cross-correlation.

- Generate an initial fiducial model.

- Refine the initial Fiducial model by minimizing residual
error distances.

- Re-position the tomogram, in order to identify the
appropriate tilting axis direction.

- Producing a final aligned stack.

- Reconstruct the actual tomogram.

- Trim and scale the tomogram.

- Remove intermediate files.
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In this practical, however, the tilt stack does not seem have any major pixel correction 
to perform, so here pre-processing is not strictly needed. The procedure is anyways 
described below, but you can press Done and continue to the coarse alignment (next 
page).  

The basic steps involved in ccderaser pre-processing are: 

• Press Find X-rays (Trial Mode) to find potentially anomalous pixels.

• Press View X-ray Model to check whether or not are you satisfied with the selection
of allegedly erroneous pixels.

• Press Show Min/Max for Raw Stack to run clip stats, a program which displays the
minimum and maximum densities for each section, on the raw stack.

• Press Create Fixed Stack to create a second stack where X-rays are removed.

• Press View Fixed Stack to view that stack and again Show Min/Max for Fixed Stack
to run clip stats on the fixed stack.

If the outlier pixels from the raw stack clip stats output are gone or improved from the 
fixed stack output, then press Use Fixed Stack and Done. 
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2. Coarse alignment

Press Coarse Alignment to 
create the coarse aligned stack. 
The default parameters are 
sufficient for aligning the tilt 
series in this practical. 
Calculate Cross-Correlation 
runs the program tiltxcorr. The 
program uses cross-correlation 
to find an initial translational 
alignment between successive 
images of a tilt series (i.e. just 
shifts in x and y). The output file 
will have the extension .prexf, 
and will be a list of 
transformations (recommended 
shifts) that will be applied to the 
image data in the next step. 

Pressing Generate Coarse Aligned Stack will run two programs: 

1. xftoxg, that takes the transforms created by tiltxcorr to obtain a single consistent or
‘global’ set of alignments.

2. These new transforms are then applied to the image data using the program newstack.
The output file created has the extension .preali. To view the pre-aligned stack,
press View Aligned Stack in 3dmod.

Summary 
In this step, we are doing a quick alignment of our tilt stack using cross-correlation. 

• Click Calculate Cross-Correlation

• Click Generate Coarse Aligned Stack

• Click Done

You can also click View Aligned Stack in 3dmod to check the alignment.
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You should be able to see a smooth alignment among 2D slices (i.e. no large shifts 
between adjacent slices). Incorrect shifts can be fixed manually with the interactive 
program Midas, activated by pressing Fix Alignment With Midas. There is no need to 
do it in this data set.  

If you are satisfied with the pre-aligned stack, press Done and proceed to the fiducial 
model generation to fine tune the alignment of the stack using gold fiducials. 

Troubleshooting 
• If something does go wrong with your coarse alignment, click the little A button

in the top-right corner of the Coarse Alignment window. This will bring up
the advanced options with an extensive set of parameters to play with. It is
always possible to go back to the basic set of parameters by clicking the B
button.

• The first step to fix bad coarse alignments is using the Coarse aligned image
stack binning in the newstack advanced options.

• Sometimes you may need extra information regarding advanced options. Keep
in mind that all of the programs mentioned here are IMOD commands that can
be run in a terminal. For example, typing:

Ø tiltxcorr

will start the tiltxcorr program.

IMOD commands have also exhaustive manual pages. For instance, typing in a
terminal:

Ø man tiltxcorr

will tell you the list of mandatory and optional parameters that can be used.
More information about the algorithm used is also provided. Press q to leave
the manual page.
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3. Fiducial Model Generation

Gold beads are excellent landmarks to be used as fiducials for aligning a 2D tilt 
projections stack. This is because gold beads are approximately spherical, homogeneous 
and isotropic. They appear as high contrast dark disks even in projections acquired at 
high tilt angles. Therefore, the center of each 2D disk can be easily identified and tracked 
throughout the tilt projections stack. The high contrast of gold beads is due to their 
greater electron density compared to the rest of the sample, which is vitrified biological 
matter. 

The aims of this step are: 

1. locate gold bead fiducials in the lowest tilt image of the stack (near zero degrees), to
create a ‘seed’, or starting positions, useful for the creation of an initial fiducial model
(Seed Model tab).

Summary 
In this step, we are locating the positions of our gold fiducials, so we can use them 
to do a more accurate alignment in the next step.  

1. Make sure the Make seed and track and Make seed model manually options
are selected. Click Seed Fiducial Model.

2. In the Beadfixer dialog box that opens, make sure to check the Automatic new
contour option.

3. Use the middle mouse button to pick as many gold beads as you can from a low
angle tilt image (the gold beads are the black dots disperse in the image). Save
the model file (File ➜ Save Model, or type s) and close 3dmod.

4. Switch to the Track Beads tab and click Track Seed Model.

5. Click Fix Fiducial Model. In the Bead Fixer window, click Go To Next Gap. If
you see a down arrow over the bead in the ZaP window, press [Page Down]
and use the middle mouse button to add the missing point. If you see an up
arrow, click [Page Up] instead.

6. Repeat the previous step until the no more gaps are found message appears. Save
the model file (File ➜ Save Model, or type s) and close 3dmod.

7. Click Done in the Fiducial Model Gen. window.
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2. Create an initial fiducial model. Track the same beads in all the other tilt images,
based on the angle information and on their distance from the tilt axis (Track Beads
tab). The resulting initial fiducial model will be refined in the next step.

There are the three alternatives to create an initial fiducial model: 

• Make seed and track: this is the standard method for creating fiducial models using
gold beads, or any other highly electron dense, spherical object.

• Use patch tracking to make fiducial model: this is the method used when there are
no beads available. Patch tracking cross-correlates overlapping patches from your tilt
images to build a model. This method is generally more difficult and prone to
problems. It is almost always better to use beads.

• Run RAPTOR and fix: this is an old program to automatically find and track gold
fiducial markers through the tilt series. We will ignore this option, because the IMOD
fiducial model generation works fine enough for our purposes.
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Make sure the Make seed and track radio button is selected. 

In the Seed Model tab there are two options for making our seed model: 

1. Make seed model manually and

2. Generate seed model automatically. We will be doing this manually, but the
procedure for generating the seed model automatically will also be described.

Select Make seed model manually and click View Seed Model. 3dmod will open and 
three windows will appear: the big ZaP window, that displays the image stack, the 
3dmod control window, and the Bead Fixer dialogue box. In this new window, check 
the Automatic new contour option. This will generate a new contour for every point in 
a new position. The rest of the parameters can be left as default. 

3dmod model mode tips 
When making a model in 3dmod, everything you picked is grouped into a 
hierarchical structure. Your Points are grouped into Contours, and your Contours 
are grouped into Objects. 

• [Page Up] and [Page Down] move you through the image stack.
• Left-click the mouse to select the nearest point.
• Left-click and drag to pan the image around.
• Right-click to reposition the current point.
• [Ctrl + right-click] to delete the current point.
• The [Up] and [Down] arrow keys step the zoom factor up and down.
• Press ‘V’ to see a 3D view of the models.

Movie/model mode 

Object/contour/ 
point number Coordinates of 

current point 



13 
 

In the ZaP window, scroll to the slice closest to the 0˚ angle and select as many gold 
beads as you can by using the middle mouse button. They appear as dark disks in the 
image. Zoom in and out to facilitate selection. 

Try to pick at least 10 gold beads evenly distributed over the whole field of view. The 
more you have, the better your alignment will be, even if more beads also mean more 
work to align all of them.  

Once you are done picking gold fiducials for the seed model, save it (File ➜ Save or type 
S) and close 3dmod. 

 

Now click on the Track Beads tab and Track Seed Model button. This will run the 
beadtrack program to find the previously picked gold beads in all other tilt images. The 
resulting fiducial model needs to be manually refined, to correct for incomplete tracking 
by either deleting a fiducial from the model or completing the tracking.  

If bead tracker is unable to find any of the beads through the tilt series, they will be listed 
in the ETomo Project log file. If you have any gaps, before moving to Fix Fiducial Model, 
you can try the Track with Fiducial Model as Seed, as this may automatically fill in 
some of the gaps. 

Press Fix Fiducial Model (even if you have no gaps you should still use this option). 
This procedure will display magenta and green points, corresponding to the position of 

A brief overview of automatic picking 
Selecting Generate seed model automatically will allow you to use the autofidseed 
program to automatically find your gold beads. 

• In the Selection and Sorting Parameters window, enter ‘20’ in the Seed Points to 
Select, as the Total number of gold fiducials to find. Make sure Select beads on 
two surfaces is checked.  

• Click Generate Seed Model to automatically detect most  of the gold particles 
on top and at the bottom of the section. 

• When done, click Open Seed Model to display the gold particles selected in the 
tilt series. 

Autofidseed does a good job on most occasions, but it will struggle with beads near the 
edge of the image and overlapping beads. 
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the picked gold beads either on top or at the bottom of the tomogram. You can switch 
to movie mode in 3dmod and click the middle mouse button to scroll through the tilt 
series and check that beadtrack program has worked. Then, get back to model mode in 
3dmod before continuing. 

The Bead Fixer dialog box will appear in Fill gaps mode. Go to Next Gap (or 
[Spacebar]) will bring you to the first gap. In the ZaP window you will see a point 
highlighted with a yellow circle and a yellow arrow indicating the adjacent section that 
has a missing model point. Using the keys [Page Up] for the arrow pointing up, or 
[Page Down] for the arrow pointing down and find the slice where the point is missing. 
Middle mouse click in the center of the gold particle will add the missing point. It is 
useful to increase the magnification of the image with the [+] key and adjust the contrast 
on the sections, especially at high tilts or at the edge of the slices. In case the missing 
point ends up being outside of the image, the easiest fix is to delete that contour by going 
back to the section where the point is selected in yellow and click Edit Contour Delete 
in the 3dmod control window, or type [Shift+d].  

It is helpful to open the Bead Helper from 3dmod main window by clicking Special ➜ 
Bead Helper. This will trace a trajectory line for each contour of picked gold fiducials, 
to better visualize the fiducial model and spot misplaced or wrongly placed contours 
right away. 

Repeat this procedure for all missing points in the fiducial model by clicking on Go to 
Next Gap until the message, ‘No more gaps are found’ comes up in the main 3dmod 
window. Repeat this procedure for any other missing points in the fiducial model by 
clicking on Go to Previous Gap until the message, ‘No more gaps are found’ comes up 
in the main 3dmod window. 

Press [V] to open a 3D view of the models – they should be visible now as smooth 
curves. If any point seems out of position, select it by left-clicking on it in the ZaP 
window, then use right-click to reposition it. Once done, save the model file (File ➜ 
Save or type S), close 3dmod, and click the Done button to advance to the fine alignment 
step. 
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4. Fine Alignment

In the previous step you used gold beads as landmarks for creating an initial fiducial 
model. In this step you will use the “residual” measure of error to refine the alignment. 
In fact, IMOD assigns to each fiducial in each projection a value called “residual”, which 
represents the distance in pixels between the expected and the actual position of the 
fiducial. In general, the smaller is the residual error, the better is the alignment. 

The Fine Alignment panel is organized within three tabs, each containing the 
parameters for different type of alignments. Ensure that the Assume fiducials on 2 
surfaces for analysis option is selected in the Analysis of Surface Angles menu box. A 
general alignment is done when you press Compute alignment at the bottom of the 
Fine Alignment box. 

Summary 
In this step, you will use the fiducial model created to align as precisely as possible 
the tilt stack.  

1. Click Compute Alignment.

2. When the alignment is computed, click View/Edit Fiducial Model.

3. In the Bead Fixer dialogue box, click Go To Next Big Residual.

4. Click Move Point by Residual. If this produces an inaccurate shift from the
center of the gold fiducial, then manually adjust it using the right mouse button
(zoom if necessary).

5. Repeat the steps 3 and 4 until the no more residuals are found.

6. Press the Save & Run Tiltalign button in the Bead Fixer dialog box. In the
Project Log window, check the mean residual error has decreased. The aim is to
have a mean residual error between 0.6 and 0.2.

7. Repeat steps 3-6 until the mean residual error stops decreasing, or there are no
more residuals.

8. Save the model file (File ➜ Save or type S) and close 3dmod .

9. Click Done in the Fine Alignment window.
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This runs the program tiltalign to solve for the displacements, rotations, tilts and 
magnification differences in the tilted views. The program uses the position of the gold 
beads in the fiducial model and a variable metric minimization approach to find the best 
fit. The residual error and the standard deviation for the alignment solution are also 
displayed in the ETomo Project Log file (this log window opens when ETomo starts). 

tiltalign also creates two model files that provide useful information about the fiducial 
model. The first file (20141001_u87mg_60eA_7def_50x_tomo2.3dmod) displays a 3D 
model of the fiducials based on their solved positions. Fiducials are represented as 
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magenta and green spheres according to which surface they are located. Examine this 
model by hitting the View 3D Model button on the bottom of the Fine Alignment box: 

You should see a nice distribution of magenta and green spheres across the field of view. 
Rotate the model from the top view to the side view by toggling between the [F] and 
[T] keys. You will see the separation of the two surfaces with this view. Close the 3dmod
window.

If the distribution of the gold beads is fairly even, you can move to the Global Variables 
tab and select the Full solution for Distortion Solution Type. This option will allow the 
program to correct for both X-axis stretch and Skew distortions.  

Note that solving for distortion effects can lead to improper, overfitted solutions, and 
should only be used if you think it is really necessary. You can find more information 
in the IMOD website: 
https://bio3d.colorado.edu/imod/doc/tomoguide.html#FINAL%20ALIGNMENT. 
There is no need to use it in the specific case of this tomogram.  

Once done, go back to the previous tab (General) and click Compute alignment again. 

Press View/Edit Fiducial Model to reload the fiducial model for editing. This will bring 
up the Bead Fixer dialog box in Fix big residuals mode (see below) and load the relevant 
details from the align.log file (reported in the 3dmod dialogue box below). 

Top view Side view
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The goal of the fine alignment step is to reduce the mean 
residual error to a subpixel value (<1 pixel). The following 
iterative steps involve fixing fiducial points with large residuals: 

• Click Go to Next Big Residual in the Bead Fixer dialog box.
This will select the model point that had the biggest residual
and you may see that it is not centered properly on the gold
bead. You can also see a red arrow pointing in the direction of
the recommended move (if not, use the zoom controls in the
top left corner of the ZaP window or press [+] key until it is big
enough for you to see).

• If you click Move Point by Residual in the Bead Fixer dialog
box, it will move the model point by the recommended amount.
This works most of the time, but if the suggested position looks
wrong, you can move it by manually by centering the cursor in
the center of the gold bead and then clicking the right mouse
button to shift the point in the right position.

Repeat these two steps until the Go to Next Big Residual 
shows that no more residuals are found in the 3dmod control 
window. At this point you can save the model by clicking on 
Save and Run Tiltalign in the Bead Fixer dialogue box.  

If you check the ETomo log file you should see that the residual and standard deviation 
have decreased. Repeat this process until there are no more residuals or until the mean 
residual error does not decrease any further. Save the model (File ➜ Save or type S) and 
close 3dmod. Then press Done. If ETomo asks you if you want to save the model select 
‘yes’. 
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Hints for a better fine alignment 
In general, the smaller the residual error, the better the alignment. Please 
note that the mean residual error is an integrative measure of self-
consistency of the fiducials model. This means you can have a subpixel 
mean residual error (<1.0) and yet an unaligned model. For example, this 
may be the case if you click Move All by Residual.  
Furthermore, you may have a good subpixel alignment and yet a high mean 
residual error. This may happen if some of your gold beads sit in unstable 
locations, like at the edge of your grid, and move during acquisition.  
Moreover, the mean residual error tends to increase proportionally to the 
number of gold beads used.  

The take-home messages are: 

1. always check what gold bead are you picking

2. never use Move All by Residual, unless you have an extremely good
reason to do so, and

3. think of the mean residual error as a relative indicator of how your
alignment is progressing, rather than an absolute indicator of how your
alignment is.
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5. Tomogram Positioning

In the previous step, you probably noticed that the position of the gold beads in the side 
view is slightly tilted in respect of the coordinate axes. In this step, we are calculating 
the shifts and angles needed to re-position the tomogram correctly in the coordinate 
space, thus identify the exact tilting axis direction.  

Make sure the Positioning tomogram thickness is set to a very large number, like 
‘3000’. This number describes the side of a cubic volume (voxels) that will surround the 
tomogram, you want it much larger than needed to better locate the tomogram data. 
Check the Use whole tomogram option and set the Binning to ‘6’. Click on Create 
Whole Tomogram and wait for it to complete. It may take a while and the loading bar 
will get completed twice: first to make an aligned stack and second to create the actual 
tomogram. 

Summary 

1. Enter ‘3000’ in the Positioning tomogram thickness box, to have a very large
view of the tomogram position.

2. Make sure Use whole tomogram is selected, and Binning is set to ‘6’.

3. Click Create Whole Tomogram. Wait until this is complete, then click Create
Boundary Model.

4. In the opened 3dmod window, go to “image>XYZ” or press [Ctrl-X] to open
the XYZ view. Use this to create 12 model points (4 per each position at the top,
middle and bottom) using the middle mouse button. The points should form 2
parallel lines in each position, 3 above and 3 below the tomogram. Save the
model (File ➜ Save or type S) and close 3dmod.

5. Click Compute Z-shift and Pitch Angles.

6. Click Create Final Alignment.

7. Click Done.
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Next click on Create Boundary Model. This will open 3dmod and give you a first 
glimpse of the actual tomogram. Note that it is binned, and therefore much smaller (and 
with higher contrast) than your final tomogram will be.  
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The figure on the right shows the tomogram viewed from 
the side (i.e: the view of the tomogram when the Y axis is 
perpendicular to the page). The mottled band across the 
center is the actual tomogram, and you can easily see that 
it is not perfectly parallel to its bounding box. 

To allow ETomo to correct for that, press [Ctrl-X] in the 
ZaP window to open an XYZ view. Play with the sliders at 
the top to view different slices of the tomogram from the 
three different axes, X, Y and Z.  

If the tomogram data is not easy to locate, close 3dmod and increase the Positioning 
tomogram thickness value. As before, click Create whole tomogram and, once done, 
Create Boundary model to have a larger bounding box. You can also increase the value 
of “Sum” in the XYZ view, this will average several adjacent views, increasing their 
signal-to-noise-ratio (SNR).  

In this step of the reconstruction, 3dmod expects you slice the tomogram until one of its 
ends and create 2 horizontal lines, to delimit the actual tomographic data (as shown on 
the right).  

In the top left window of the XYZ viewer (XZ plane), use 
the Y-slider to go to one end of the tomogram and middle 
click to place two connected points above and two below 
the data (they will be automatically connected in pairs as 
different contours).  

Once done, slice the tomogram somewhere in the middle 
and, placing points as before, create another two lines to 
delimit the tomogram.  

Finally, slice the tomogram to the other end and repeat 
this step for the last time.  

You should now have 6 lines that delimit the top and 
bottom of the tomographic data in 3 different positions of 
the tomogram (end, middle and opposite end), using a 
total of 12 model points and 6 contours (2 points in each 
contour).  

Once done, save the model file (File ➜ Save or type S) 
and close 3dmod. 
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Click Compute Z Shift and Pitch Angles to find the pitch of the section on the three 
regions using the IMOD program tomopitch. Tomopitch analyes simple models of the 
boundaries of the section in slices from a tomogram and recommends how much to 
change tilt angles to make the section flat, how much to shift the tilt axis in Z to produce 
centered slices, and how thick to make the slices.  It can also recommend how much X-
axis tilt is needed to make the section flat in the orthogonal direction as well.  It can also 
be used with a model drawn on a whole tomogram, possibly binned down. 

Press Create final alignment to apply these values to the alignment solution. 

Finally, press Done. 

. Final Alignment 

The final alignment step will finalize and create the best aligned tilt stack to be used in 
the tomogram generation step.  

Summary 
In the final alignment step, the final aligned tilt stack will be created, last alignment 
step before the final tomographic reconstruction. Although there are multiple useful 
options here, we will be skipping some of them for the interests of time. 

1. In the Create tab, change the Aligned image stack binning to ‘2’.

2. Turn on the Reduce size with anti-aliasing filter.

3. Click Create Aligned Stack.

4. Click Done.

If you want to know more about the other options, check the IMOD tomography 
guide (https://bio3d.colorado.edu/imod/doc/tomoguide.html#FinalAligned). For 
more info on how to use ctfplotter to correct for CTF effects, check out the CTF guide 
as well (https://bio3d.colorado.edu/imod/doc/ctfHelp/ctfguide.html). 
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You may consider binning the data, to reduce the size of the reconstructed tomogram 
and to speed up the actual reconstruction. Binning the data may also be recommended 
if your aim is to quickly inspect your reconstruction. In fact, binning increases the SNR, 
and the contrast of the reconstructed volume. However, binning reduces the maximum 
resolution you can achieve with your data. Thus, the decision of whether or not you may 
want to bin the data depends on the aim of your investigation. 

For this practical, we bin the tomogram by a factor of 2, in the interest of time. To do 
so, change Aligned image stack binning to ‘2’ and make sure that Reduce size with 
antialiasing filter is selected.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Finally, click Create Full Aligned Stack and wait for program to finish running. Once 
done, click View Full Aligned Stack to open 3dmod and have a look.  

Click Done to finish this step and move to the tomogram generation. 
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However, further processing of final aligned stack may be important for obtaining higher 
quality tomograms. For example, it has been shown in literature that local regularization 
of tilt projections can reduce artifacts in electron tomography. Contrast transfer function 
(CTF) correction may also be useful if you are aiming to achieve high resolutions. As 
you might have noticed, there are three more tabs after the Create one. Although we 
will be skipping them in this practical, they contain useful functions for cryo-tomography 
reconstruction and it is worth to know what each of them does.  

Below is a brief description of each one. 

Correct CTF: this tab leads to the ctfplotter program, where the CTF correction is 
calculated needed to compensate for defocus-based aberrations. Note that this is slightly 
different to CTF correction for single particle images, as it also deals with the variation 
in defocus across the images in the stack caused by the tilt. Note that the version of 
IMOD we are using here, and older versions, require a config file containing the locations 
of noise images. Newer versions of IMOD (4.10 onwards) have eliminated this 
requirement. For more information on CTF correction and using the ctfplotter user 
interface, visit: https://bio3d.colorado.edu/imod/doc/ctfHelp/ctfguide.html. 

Erase Gold: gold nanoparticles are extremely useful in aligning the tilt stack. However, 
they are highly electron dense, thus they can hide proximal biological structures and 
degrade the overall quality of the reconstructed tomograms. This tab will locate gold 
beads and replace their intensity level with a constant value (either the average value of 
surrounding pixels or the mean intensity value of the whole image). As a result, this 
process drastically decreases the contribution of artifacts in the reconstructed volume. A 
more general result can be achieved using the IMOD command preNID, which aims to 
reduce gold-related artifacts without erasing the gold particles. 

2D Filter: allows you to apply pre-reconstruction low-pass filters to each image in the 
tilt stack. See the ‘2D Lowpass Filtering in IMOD’ box below to see what the filtering 
parameters mean. However, IMOD provides more effective pre-reconstruction filters, 
such as preNAD (see man preNAD for a more accurate description). 
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7. Tomogram Generation

Summary 
In this step we will finally reconstruct the tomogram.  

1. Click Generate Tomogram and wait for a while for it to finish. 

2. Click Done.  

2D Lowpass Filtering in IMOD 
Low pass filters in IMOD require you to input two values. The first number is the 
cutoff – frequencies higher than this value will be attenuated. The second number 
is the sigma value for the Gaussian dropoff – this describes how ‘quickly’ the 
attenuation occurs. This is needed because a sharp cutoff in Fourier space leads to 
odd artefacts in real space. The cutoff value can be translated into Ångstroms by 
dividing the pixel size of your image by the cutoff. For example, if your pixel size is 
4.22, a cutoff value of 0.35 means you are attenuating frequencies higher than ~12Å 
(4.22/0.35). A cutoff value of 0.5 is therefore the same as the Nyquist limit of your 
image.  

Below are three Fourier transforms of an image showing the effects of different 
filtering values. 

No filtering Cutoff 0.25
sigma 0.01

Cutoff 0.25
sigma 0.05

Summary 
A few final adjustments to scaling and position. 

1. Deselect Convert to bytes.

2. Click Trim Volume and wait for it to finish.

3. Click Done.
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In the tomogram generation step, most of the parameters will be left as default.  

The Parallel Processing 
section at the top displays a list 
of computers available to run 
the computationally demanding 
reconstruction algorithm, along 
with some information about 
the computational load on each 
computer. This can be useful for 
SIRT reconstruction, as we are 
planning to perform Back 
Projection reconstruction, this 
option can be ignored. 

 

In the Tomogram Generation 
box there are two options for 
the reconstruction algorithms 
available: Back Projection and 
SIRT. As mentioned above, 
today, we will be using back 
projection, so make sure that it 
is selected. 

The Take logarithms of densities with offset option is used to reduce the range of 
density values in your tomogram. The default parameters for reconstruction assume that 
the numbers in your images are linearly related to the number of transmitted electrons 
caught by the detector. Deselecting it increases the dynamic range of the density but can 
sometimes cause it to take values that are too large – if this happens, a warning will pop 
up telling you so. For this tomogram, either option should work fine. 

The Tomogram Thickness in Z, Z shift and X axis tilt options should already be filled 
in, since these values were calculated in the Tomogram Positioning step, therefore 
there is no need to change them. 

The Radial Filtering options are related to the final filtering of the tomogram. It is fine 
to leave them as they are, or you can play with parameters to see different results.  

For instance, leave everything as default and click Generate Tomogram. Wait for it to 
finish, then click View Tomogram in 3dmod to see the final tomographic volume 
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reconstructed. However, you may not be satisfied with the contrast of the reconstructed 
tomogram. Set the Use SIRT-like filter equivalent to option to 5 iterations and click again 
on “generate tomogram”. This mimics a low iteration SIRT reconstruction, and acts 
similarly to a low-pass filter, thereby increasing the contrast at the expense of some high 
frequency information. 

Once you are satisfied with the reconstruction, click Done to move to the post-
processing. 

 

8. Post-processing 

This step allows to apply some final modifications to the final tomogram. We will ignore 
the Flatten and Squeeze vol tabs, as those options are particularly helpful when 
reconstructing serial sections, and not necessary in cryoEM. 

The Trim vol tab gives you the option to trim the tomogram to focus on the information 
you want. Since we are 
interested in all the data within 
our region of interest, this is 
not necessary for us. Step 
through the reconstruction and 
determine the X,Y and Z ranges 
for the final volume.  

A convenient way to set the X 
and Y range is to turn on the 
rubberband tool (the dashed 
rectangle in the toolbar of the 
Zap window), press the left 
mouse button over the upper 
left corner of the desired area, 
and drag the mouse to the 
lower right corner. Z can also 
be set, if desired; press Lo in 
the Zap window to set the 
minimum Z and Hi to set the 
maximum Z. When you press 
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Get XYZ Volume Range from 3dmod, Etomo will retrieve the X and Y values of the 
rubberband (and Z values if they are set) from 3dmod. Trimming the volume is 
performed by the IMOD command trimvol. 

The Scaling section allows you to convert your tomogram from integer or float values to 
byte values, thereby reducing the dynamic range of your tomogram, and impair further 
processing of the data. The only reason to do this is if you want to save disk space 
(tomographic data can end up being very heavy and this can sometimes be an issue). We 
are not using this option, so deselect the Convert to bytes option. 

The final box is for Reorientation. The default reorientation option will rotate the final 
volume around the X axis so that it can be read in easily by 3dmod and other programs 
without special options. Leave this option. Click Trim Volume and wait for it to finish. 

You can now click 3dmod Trimmed Volume to see your final, completed tomogram. 
Click Done to move to the very final step, which is a clean up of the intermediate files 
created in every step of the reconstruction. 

 

9. Clean up 

  

Reconstructing a tomogram in ETomo creates several intermediate files, some of them 
are superfluous after the final reconstruction. ETomo keeps of all the important files 
necessary to replicate any of the reconstruction steps, as well as the raw stack input files.  

Note: your final non-binned aligned stack may be useful in the future, for subtomogram 
averaging, or for applying further pre-reconstruction filters (for example preNAD or 

Summary 
Final step to delete all intermediate files created during every step of the reconstruction. 

1. Select all the files. 

2. Click Delete Selected. 

3. Click Done. 
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preNID), or for reconstructing the tomogram with other reconstruction software. If so, 
don’t delete the file ending in .ali. 

Use [Shift+left mouse click] to select all the files you see, and press Delete Selected. 
Click Done to complete the final clean up. 

You can now close ETomo and type in your terminal: 

> ls -lrt

This will list all the files in your reconstruction directory. Your final reconstruction will 
have the .rec extension.  

Type: 

> 3dmod u87mg_60eA_7def_50x_tomo2.rec

to open your tomogram in 3dmod and move on to Part 2 of the Tomography Practical to 
learn how to segment your tomogram. 


